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CHAPTER 7: INTERNET AND EMAIL 

Introduction to the Internet 
 It is a large no. of connected computers (or a large set of computer networks) linked together that 

communicate with each other, over telephone lines.   
 It is a worldwide computer network connecting thousands of computer networks, through a mixture 

of private & public data using the telephone lines. 
 It is a worldwide (global or an international) network of computers that provide a variety of 

resources and data to the people that use it. 
 Internet refers to a global inter-connection of computers and computer networks to facilitate global 

information transfer.  It is an interconnection of computers throughout the world, using ordinary 
telecommunication lines and modems. 

 

Features and functions of the Internet 
(i). The Internet is a collection of networks; it is not owned or controlled by any single organization, 

and it has no formal management organization.  However, there is an Internet Society that co-
ordinates and sets standards for its use.   
In addition, Networks have no political boundaries on the exchange of information. 

(ii). Networks are connected by Gateways that effectively remove barriers so that one type of network 
can “talk” to a different type of network. 

(iii). To join the Internet, an existing network will only be required to pay a small registration fee and 
agree to certain standards based on TCP/IP.   
The costs are low, because the Internet owns nothing, and so it has no real costs to offset.  Each 

organization pays for its own network & its own telephone bills, but these costs usually exist 

independent of the Internet. 

(iv). Networks that join the Internet must agree to move each other’s traffic (data) at no charge to the 
others, just as it is the case with mail delivered through the International Postal system.  This is 
why all the data appear to move at the cost of a local telephone call, making the Net a very cheap 
communication media. 
 

Functions of the Internet 
The Internet carries many kinds of traffic, and provides users with several functions.  Some of the most 

important functions are: 

1. Communication. 
Many people all over the world use the Internet to communicate with each other. 

Internet communication capabilities include; E-mail, Usenet Newsgroups, Chatting and Telnet.  You 

can send e-mails to your friends anywhere in the world, chat with your friends, send instant 

messages, etc. 
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2. Information retrieval. 
The Internet is a library.  Thousands of books, magazines, newspapers and encyclopedias can be 

read on the Internet. 

3. Easy-to-use offerings of information and products. 
You can find information for your school assignments, buy books online, check what the weather is 

like anywhere in the world, and much more. 

Internet Services 
The following are some of the services offered by Internet: 

(i). Electronic mail (e-mail). 
(ii). Fax services. 
(iii). Conference services. 
(iv). Online chatting. 
(v). Downloading of programs. 
(vi). Online shopping. 
(vii). File transfer. 
(viii). Entertainment (Games, Music and Movies). 
(ix). Free information retrieval (e.g., Educational information). 
(x). Formation of Discussion groups, e.g. Usenet Newsgroups. 
(xi). Video Conferencing. 
(xii). Access & Use of other computers. 

 

Electronic Mail (E-mail). 
An E-mail is a system that enables sending & receiving of messages electronically through computers.  It 

is used for communication between organizations or departments in the same organization. 

E-mail is a quick, cheap, efficient & convenient means of communication with both individuals and 

groups.  It is faster than ordinary mail, easy to manage, inexpensive and saves paper. 

With Internet mail, it is possible to send and receive messages quickly from businesses, friends or family 

in another part of the world.  An E-mail message can travel around the world in minutes. 

Fax services. 
Fax services enable individuals & businesses to send faxes through e-mail at a lower cost compared to 

the usual international Fax charges. 

 

Conference services. 
Conferencing on the Web can be defined as the dynamic exchange of all kinds of information – text, 

graphics, audio, video, etc – in a situation whereby the conversations are organized by item and allows a 

participant to contribute spontaneous responses to any item in the conversation. 
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Application of Conferencing on the Web. 

The conversation can: 

 Provide important information that can assist in decision-making. 

 Provide any required technical support. 

 Help in community-building, project management & distance learning. 

 Help to organize electronic meetings, etc. 
 

The Internet also allows you to have access to various types of information you might require to make 

accurate and informed decisions, E.g., it provides information on business, education, sports, politics, 

etc. 

Chatting. 
Internet Relay Chat (IRC) is a chatting system on the Internet that allows a large no. of people from 

various locations of the world who are on the computer to chat (i.e., simultaneously hold live and 

interactive electronic conversations) among themselves. 
 

You can join discussion groups on the Internet and meet people around the world with similar interests.  

You can ask questions, discuss problems and read interesting stories. 

Anyone interested in chatting can join a discussion forum on one of the listed topics.  Only people who 

happen to be signed on at the same time are able to talk because messages are not stored. 

This discussion can be an effective business tool if people who can benefit from interactive conversation 

set a specific appointment to meet and talk on a particular topic. 

Disadvantage. 

(i). Usually, the topic is open to all without security; so intruders can participate. 
 

Information retrieval. 
The Internet is a voluntarily decentralized network with no central listing of participants or sites.  

Therefore, End-users, usually working from PCs are able to search & find information of interest located 

in different sites assisted by special software and data stored in readily usable formats. 

The Internet gives you information on almost any subject.  This is because of the Worldwide Web 

(www).   

The World Wide Web is a global (an international) system of connected Web pages containing 

information such as, text, pictures, sound and video.  The WWW is hypertext based (i.e., it is able to 

access text and graphical data formatted for easy search, retrieval and display). 

With the WWW, you can review Newspapers, magazines, academic papers, etc.  In addition, 

Governments, colleges, universities, companies and individuals offer free information on the Internet.  

E.g., you can inquire (find out) about universities in Britain or America. 
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Note.  Its major problem is finding what you need from among the many storehouses of data found in 

databases and libraries all over the world. 

Dowloading of Programs. 

There are thousands of programs available on the Internet.  These programs include; Word processors, 

Spreadsheets, Electronic cards, etc.    

You can therefore, look for the latest software over the Internet, e.g., you can get the latest Anti-virus 

software, and in addition, retrieve a free trial issue. 

Entertainment. 

There are hundreds of simple games available on the Internet.  These include; Chess, Football, etc.  The 

Internet also allows you review current Movies and hear Television theme songs. 

Online Shopping. 
You can order goods and services on the Internet without leaving your desk.  E.g., you can view a 

catalogue of a certain clothes shop over the Internet and fill in an online Order form. 
 

Commercial enterprises use the Web to provide information on demand for purposes of customer 

support, marketing and sales. 
 

File Transfer. 
Data in the form of files can be transferred across the Internet from one site to another using the File 

Transfer Protocol (FTP).  FTP software is needed at both ends to handle the transfer.  It is through FTP 

that the two pieces of software manage to ‘understand’ each other. 

 

Discussion Groups. 
A Discussion group is a collection of users who have joined together to discuss some topic. 

There are many discussions on different topics including Cooking, Skydiving, Politics, Education, 

recreational, scientific research, etc. 

Two of the commonly used discussion groups for business are; 

 Usenet newsgroups. 

 List Servers. 
 

(a). Usenet newsgroups. 
These are the most formally organized of the discussion groups. 

Using a facility on the Internet called USENET, individuals can gain access to a very wide variety of 

information topics. 
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Usenet Newsgroups are usually worldwide discussion groups in which people share information 

and ideas on a defined topic through large electronic Bulletin Boards where anyone can read any 

articles or write articles and post messages on the topic for others to see and respond to. 

The individuals can add messages to different topics and read those contributed by others. For 

instance, users such as students can ask questions about problems they face, or they could 

contribute or give an advice on how to improve the teaching of the subject. 

 

Messages can be easily linked so that it is easy to know messages that are related. 

Establishing a new newsgroup requires a vote of all interested people on the Internet.  If enough 

people express interest, the new topic is established. 

Note. To join a Newsgroup and be able to read messages on various topics, your computer must 

have Newsreader software such as Outlook Express, or Internet News. 

Any Internet user can access some of these newsgroups, while other newsgroups will require to 

subscribe to a specific topic or set of topics.   

Once you have subscribed, each time you access the newsgroups you are informed of any 

new messages added to the topics.  You can then read these messages and respond to them 

by adding your own message. 

 
The Usenet software receives “postings” of information and transmits new postings to users who 

have registered their interest in receiving the information.  Each individual posting takes the form 

like that used for e-mail. 

There are over 10,000 such newsgroups; however, each Usenet site is financed independently & 

controlled by a Site Administrator, who carries only those groups that he/she chooses. 

 

(b). List Server 
 

A List Server (or list serve) group is similar to the Usenet newsgroups, but is generally less 

formal. 

Anyone with the right e-mail server software can establish a list server, which is simply a 

mail list. 

The processor of the List Server processes commands such as request to subscribe, 

unsubscribe, or to provide information about the list serve.  The List serve mailer directs 

messages to everyone on the mailing list. 

To use a List server, you need to know the addresses of both the Processor and the Mailer. 

To subscribe to a List server, you send an e-mail message to the List server processor, 

which adds your name to the list.  Many different commands can be sent to the List server 

processor to perform a variety of functions.  These commands are included as lines of text 

in the e-mail messages sent to the processor.   
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List servers are more focused that the Usenet newsgroups and have fewer members.  They 

are harder to find than the Usenet newsgroups because literally anyone can create one. 
 

Video Conferencing. 
Video conferencing provides real-time transmission of video & audio signals to enable people in 2 or 

more locations to have a meeting. 

The fastest growing form of video conferencing is Desktop video conferencing.   

Small cameras installed on top of each camera enable meetings to take place from individual offices. 

Special application software (e.g., CUSeeMe) is installed on top of each client computer.  It transmits the 

image across a network to application software on a video-conferencing Server.  The server then sends 

the signals to the other client computers that are to participate in the video conference.  In some areas, 

the clients can communicate with each other without using the server. 

Some systems have integrated other types of GroupWare with desktop video conferencing, enabling 

participants to communicate verbally to attend the same “meeting” while sitting at the computer in 

their offices. 

Advantage of Video conferencing. 

(i). Saves time & cost, as it reduces the need to travel. 
 

Access & Use of other computers. 
The Internet has a facility called TELNET that enables a user on one computer to use another computer 

across the network, i.e., the user is able to run programs on the other machine as if he/she is a local 

user. 

Telnet is a protocol, which enables a user on one computer to log in to another computer on the 

Internet. 

 
TELNET establishes an error-free, rapid link between two computers, allowing a user to log on to his/her 

home computer from a remote computer even when traveling.  You can also log on to and use third-

party computers that have been made available to the public. 

TELNET will use the computer address you supply to locate the computer you want to reach and connect 

you to it.  You will, of course, have to log in & go through any security procedures you, your company, or 

the third-party computer owner have put in place to protect that computer. 

Telnet requires an application image program on the Client computer and an application layer 

program on the Server of the host computer.  Many programs conform to the Telnet Standard 

(e.g., EWAN). 

 

Once Telnet enables the connection from the Client to the Server, you can log in by use of 

commands.  The exact commands to gain access to these newsgroups vary from computer to 

computer. 
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Telnet enables you to connect to a remote computer without incurring long-distance telephone 

charges. 
 

Telnet can be useful because, it enables you to access your Server or Host computer without 

sitting at its Keyboard.  
 

Telnet can be faster or slower than a modem, depending on the amount of traffic on the Internet. 
 

Note.  Telnet is insecure, because everyone on the Internet can attempt to log in your computer 

and use it as they wish.  One commonly used security precaution is to prohibit remote log ins via 

Tel-net unless a user specifically asks for his/her account to be authorized for it, or permit remote 

log ins only from a specific set of Internet addresses., e.g., the Web server at a university can be 

configured to only accept telnet log ins from computers located on the Kabete Campus network. 
 

Electronic Commerce.  
Many people are actively using the Internet for Electronic Commerce (i.e., doing business on the 

Internet). 

The use of the Internet in E-commerce is not necessary for making money as such, but mainly to find 

information, improve communication and provide information. 

Many people automatically focus on the retail aspect of e-commerce, i.e., selling products to individuals.  

However, this is just one small part of e-commerce.  The fastest group and the largest segment of e-

commerce is business-to-business settings. 

There are 4 ways in which the Web can be used to support E-commerce; 

(i). Electronic Store. 
Electronic Store is a Website that lists all the products or services a business wishes to sell, thus 

enabling customers to purchase them by using the Internet itself.   

E-store sites provide physical goods and services.   

The cost of providing information on the Web is low (unlike a Catalog, in which each page adds to 

the cost), and therefore, electronic stores can provide much information.  In addition, electronic 

stores can also add value by providing dynamic information. 

E-mail can also serve the purpose of E-store.  This is because, e-mail is essentially a collection of e-

stores.  The mail usually provides all the computer information needed for e-commerce, and 

advertises the mail to potential customers.  In return, the stores pay the mail a monthly fee or 

some percentage of sales. 

(ii). Electronic Marketing. 
E-marketing sites focus on the products or services of one company with aim of increasing sales.   

This type of site supports the sales process, but does not make actual sales.  The goal is to attract 

and keep customers.   
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By doing so, such sites provide a wealth of information about the firms and products complete 

with technical details and photos.  Customers can review these but cannot buy over the Web.  The 

idea is to encourage the user to visit a local dealer, who will then make a sale.   

Computers also use e-marketing sites to provide newsletters with information on the latest 

products and tips on how to use them.  Other companies enable potential customers to sign up for 

notification of new product releases. 

E-marketing is cheaper in many ways than traditional marketing (radio, direct marketing, TV or 

print media).  This is because while it costs the same to develop these traditional media, it costs 

nothing to send information to the customers.  It is also easier to customize the presentation of 

information to a potential customer, because the Web is interactive.  In contrast, the other media 

are fixed once they are developed, and they provide the same marketing approach to all who use 

it. 

(iii). Information / Entertainment provider. 
The Information/Entertainment provider supplies information (in form of text or graphics) or 

entertainment.  These providers provide information from many sources with an aim of helping 

the users. 

Several radio and TV stations are using the Web to provide broadcast of audio and video.  The Web 

also offers new forms of real entertainment e.g., enables new multiplayer interactive games, 

which are not available in any other media.  The information / entertainment providers generate 

revenue by selling advertisement printouts. 

(iv). Customers Service sales. 
This provides a variety of information for customers after they have purchased a product or service 

– to allow customers access most commonly needed information 24 hrs a day.  

Many software companies post updates that fix problems so that customers can download for 

themselves.   

Customer service sites benefit both the company and the customers.  They enable customers to 

get a 24 hr support and easy access to needed information.   

They often reduce the no. of staff needed by automating routine information requests that 

previously had to be handled by an employee.   
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GroupWare. 
 

GroupWare is a software that helps groups of people to work together more productively. 
 

They are often organized using a two-by-two grid. 

 

Same place Same time Different time 

 Group support systems Group support systems 

Different 

place 

Video teleconferencing, Desktop 

video teleconferencing 

E-mail, Discussion groups, Document-

based GroupWare 

GroupWare allows people in different places to communicate either at the same time (as on a 

telephone) or at different times. 

GroupWare can also be used to improve communication and decision-making among those who 

work together in the same room, either at the same time or at different times. 

GroupWare allows people to exchange ideas, debate issues, make decisions, and write reports, 

without actually having to meet face to face.  Even when groups meet in the same room at the 

same time, GroupWare can improve meetings. 

The major advantage of GroupWare is its ability to help groups make faster decisions, 

particularly in situations where it is difficult for group members to meet in the same room at the 

same time. 
 

The 3 most popular types of GroupWare are; 

- Discussion groups. 

- Group support systems. 

- Video Conferencing. 
 

Group Support Systems (GSS). 

Both e-mail and documents-based GroupWare are designed to support individuals and groups working 

in different places at different times.  They are not suited to support groups working together at the 

same time and in the same place.  In addition, they don’t provide advanced tools for helping groups to 

make decisions. 

Group Support Systems (GSS) are software tools, designed to improve group’s decision-making.  GSS 

are used with special-purpose meeting rooms that provide each group member with a network 

computer plus a large screen video projection system that acts as electronic blackboards.  These rooms 

are equipped with special-purpose GSS software that enables participants to communicate, propose 

ideas, analyse options, evaluate alternatives, etc.  Typically, a meeting facilitator assists the group. 

The group members can either discuss verbally or use computers to type ideas and information, which 

are then shared with all other group members via the network.  For large groups where only one person 

can speak at a time, typing ideas is faster than talking.  Everyone has the same opportunity to contribute 

and ideas can be collected much faster.  In addition, GSS enables users to make anonymous comments.  

Without anonymity, certain participants may withhold ideas because they fear their ideas may not be 

well received. 

The system also provides tools to support voting and ranking of alternatives, so that more structured 

decision-making process can be used. 
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Just like in document-based GroupWare, vendors use the Web browser as their client software.  So, 

almost anyone can access GroupWare Server. 

Note. Discussion groups, document-based GroupWare and GSS all focus on the transmission of 

text and graphical images. 
 

Importance of services provided on the Internet. 

The services offered by the Internet can be used as important tools in various ways: 

1). As a research tool: 
To learn about new developments or products, competitors, market news and customer opinions. 

2). As an advertising / trading tool: 
To help in selling goods or delivering information through the Web pages to customers on a 24-hour 

basis. 

3). As a communication tool: 
To support communication with customers, suppliers or staff through Electronic mail (e-mail). 

4). As an Entertainment channel: 
Most of the Games, Movies, and Television theme songs are available for free on the Internet. 

In addition, you can have live, interactive conversations with people around the world including 

celebrities. 

Browsing the Web 
This is also known as Navigating or ‘Surfing’ the Web. 

 To Browse is to navigate the Internet or the contents of your computer. 
 Browsing can also be defined as moving around and between Web pages.   

 

Using a Web browsing software you can read documents, listen to music, watch videos, make 

purchases, participate in surveys, advertise products, do research, share interests and download 

files on the Web. 
 

EXPLORING / BROWSING THE INTERNET.  

Use the Internet Explorer on your Windows desktop to browse the Web.  

There are several ways in which you can browse the Web pages or “surf the net”. 

(a). When viewing a Web page, you can navigate the Internet by clicking Links, Underlined text or 
special features that cause you to jump to another Web page. 
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Hyperlinks. 

A Hyperlink is a coloured or underlined text or a graphic that you click to ‘jump’ from one location 

to another.  The hyperlinks enable the user to ‘jump’ to another file, or to another location in the 

same file. 

All Web pages have hyperlinks.  These links: 

(i). Connect one part of a Web page to another part of the same Web page.  This is useful if the 
Web page is large. 

(ii). Connect one Web page to another Website somewhere on the Web. 

(iii). Connect a page to a file, such as a sound clip, video, a Spreadsheet or a Word document. 
 

The links can connect to objects stored anywhere on the Internet.   

Hypertext links are indicated by underlined text highlighted usually in blue.  Hyperlinks can also be 

represented by buttons, graphics or pictures. 

To find hyperlinks on a page, move your mouse pointer over the page and where there is a 

hyperlink, the mouse pointer will change into a hand with a pointing finger.  When you click a link, 

another Web page appears. 

As you browse the Web, Internet Explorer stores the sites and pages that you visit.  Usually, the 

hyperlinks you previously selected are colored differently.  Internet Explorer does this to remind 

you that you have already visited the page identified by this link. 

(b). You can also use the Standard toolbar buttons in the Internet Explorer to move between Web 
pages, or to search the Internet. 

 

History. 
Internet Explorer remembers the Websites and Web pages that you have visited.  It keeps record of 

each Web page as it is downloaded.  This is the History feature. 

You can therefore, easily return to the page you have visited.  To redisplay the page you have just left, 

click on the Back button.  To move to the next page (available only if you have moved back), click the 

Forward button. 

Web Hosting. 

A World Wide Web Server is a computer with programs that answer requests for documents from 

Clients (browsers) over the Internet.  Files containing Web sites are placed on these servers.   

A Host computer is any computer connected to the Internet and stores information that has been made 

available to the Web. 

ISPs also use host computers to store user’s electronic mail messages, Web sites and other related 

facilities such as, support software and appropriate security. 
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Web Address (Uniform Resource Locator – URL). 

An Address is the location of a file.    

Each Web page in the world has a unique Internet address or location.  Internet addresses are also 

called the Uniform Resource Locator (URL).  E.g., the general URL for Microsoft is 

http://www.Microsoft.com./  

You can use addresses to find files on the Internet & your computer.  You can instantly display any Web 

page if you know its URL.  E.g., http://www.compaq.com.     

AutoComplete - A feature in the Address Bar.  When you begin typing a previously used address, this 

feature finishes it as you type. 

How the Web Works. 

 
Each Client computer needs an application software package called a Web browser, such as 

Navigator, Internet Explorer.   

Each Server on the network needs an application software package called a Web Server.  There 

are many different Web servers, such as those produced by Netscape, Microsoft and Apache. 
 

In order to get a page from the Web, the user must type the Uniform Resource Locator (URL) 

for the desired page, or click on a link that provides the URL.  The URL specifies the Internet 

address of the Web Server, the directory and the name of the specific page required.  If no 

directory or page is specified, the Web server will display whatever page has been defined as its 

Home page.  If no server name is specified, the Web browser will assume that the address is on 

the same server and directory as the last request. 
 

http://www.microsoft.com./
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In order for the Web server to understand requests from the Web browser, they must use the 

same standard protocol.  If there was no standard, then each Web browser would use a different 

way to request pages.  This means that, it would be impossible for a Web browser from Netscape 

to communicate with a Web server from Microsoft. 

The standard protocol for communication between a Web browser and a Web server is the 

HyperText Transfer Protocol (HTTP).  An HTTP request for a Web browser to a Web server 

has 3 parts, but only the 1
st
 part is required, the other two are optional. 

 

 The Request Line, which starts with a command (e.g., GET), provides the URL, and ends 

with HTTP version number that the browser understands. 
 

 The Request Header, which contains a variety of optional information such as the Web 

browser being used (e.g., Internet Explorer), the date, the User ID and Password for using 

the Web pages as password protected. 
 

 The Request Body, which contains information sent to the Server, such as information from 

a firm. 
 

Note.  Every Web user must provide the Internet address of the receiving computer, otherwise, 

the server would not know where to send the requested page.   

Some browsers also provide the requestor‘s e-mail addresses as well.  Most Web servers keep a 

record of Internet addresses of all the requests (and the e-mail address, if provided by the 

browser).  Some companies use this information to make a follow up with prospective 

customers. 
 

An HTTP response for a Web server to a Web browser also has 3 parts, but only the last part is 

required, the first two are optional. 
 

 The Response Status, which contains the HTTP version number the server has used as 

status code (e.g., 200 means ‗OK‘, 404 means ‗Page not found’), and reason phrase (i.e., a 

text description of the status code). 
 

 The Response Header, which contains a variety of optional information such as the Web 

server being used, the date, the exact URL of the page in the response body, and the format 

of the body (e.g., HTML). 
 

 The Response Body, which is the Web page itself. 
 

Internet Addresses. 
Internet addresses are strictly regulated, otherwise, someone could add a computer to the Internet that 

had the same address as another computer. 

Each address has 2 parts; The computer name and its domain.   

The Domain is the specific part of the Internet to which the computer is connected (e.g., Canada, 

Australia, etc).   

 

The general format of an Internet address is therefore: computer.domain.  Some computer names have 

several parts separated by periods.  For example, the main university Web server of an imaginary 
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University like Yairobi can be www.Yairobi.edu, while the college of Humanities and Social Sciences 

server can be www.chss.Yairobi.edu.  

Each domain has an address board that assigns address for its domain.  The boards ensure that there are 

no duplicates. 

Finding Web pages (information) on the Web. 
There are 3 ways you can use to find interesting and useful Web pages on the Web; 

1). You could get the Web address from an advertisement. 
Many businesses include their Web addresses in their Television and Print advertisements. 

2). You click a link that will enable you jump from one page to another. 
Many industries or organizations, magazines and topic experts maintain pages that provide links 

from page to page. 

3). Use of Search Engines. 
 

Search Engines / Search Services. 
 A Search engine is software that helps in locating information in the Web. 
 Search engine is a tool that searches the Web for information that you want to find.   

 
Purpose. 

√ If you want to get some information concerning an area or subject of interest over the Web but you 
do not know where to find it, you can use a Search engine to locate sites that contain the 
information. 

√ Locate particular information in a Website, e.g., if you wish to read the Sports news you can load a 
Web site like http://www.cnn.com/, and then use a search engine within that site to locate 
information on Sports. 
 

The following are the various search engines: 

1). Yahoo – www.Yahoo.com.  
2). AltaVista – www.altavista.digital.com.  
3). Excite – www.excite.com.   
4). Meta Crawler – www.metacrawler.com. 
5). Infoseek. 
6). Lycos. 
These search engines offer different kinds of searching capabilities.  However, they differ in the way 

they organize information in response to your request. 

Yahoo focuses on the largest & most important Websites and organizes them in a directory format.  

Small and little known Websites are excluded.  Therefore, if you are looking for the address of a well-

known company or product or a popular topic, Yahoo is probably the easiest way to find it. 

http://www.yairobi.edu/
http://www.chss.yairobi.edu/
http://www.cnn.com/
http://www.yahoo.com/
http://www.altavista.digital.com/
http://www.excite.com/
http://www.metacrawler.com/
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Alta Vista is the broadest of all.  It lists almost everything it can find.  It is probably the best choice if you 

are looking for an unclear topic or a very specific combination of topics or words (e.g., to find a famous 

quote). 

The major disadvantage of Alta Vista is that, you may have to look through dozens of sites before you 

find the ones you want.  In addition, Alta Vista does not provide some help in focusing your search. 

Excite is easier to use in that, it uses advanced special intelligence techniques to help you search those 

pages that best match your interest.  E.g., after looking at the result of a search, you can tell Excite to 

find more pages that are similar to a specific page it has found.  Excite will then search again and present 

those pages first.  In this case, Excite refines the search based on the characterization of the page you 

have selected. 

Meta Crawler provides the best search facilities.  It does not search the Web and provide a list of what it 

finds.  Instead, whenever you enter a search request, it simultaneously sends that request to several 

search engines (including Yahoo & Alta Vista), then combines, and organizes the information it receives 

from all the search engines into one display. 

How Search Engines find Web pages. 

Hundreds of thousands of new Web pages are created each day. 

There are 2 ways that search engines use to locate Web pages: 

 Use of Spiders / Robots. 

 Through Submissions. 
 

(a). Spiders. 
Search Engines normally use software spiders to explore the Web.  The Spiders are usually 

automated robots that travel around the Web looking for new pages, and creating links to them. 

These spiders methodically search all the pages on the Websites they can find and report back 

their discoveries.  The search engine builds an index to these pages based on the words they 

contain.  When you connect to a search engine, and type a few words describing what you want, 

the Search engine will search its index for these keywords and provide you with a list of pages that 

contain them. 

(b). Submissions. 
These are derived from people who have created new Web pages and then submit information 

about the pages they have created. 

1. Select a search engine, e.g., Yahoo, and type its address in the Address box, i.e., 
http://www.yahoo.com/.  
Once the search engine home page appears, type a keyword or phrase in the Search box, e.g., 

Kenya, then click the Search button. 

Note.  The steps may vary depending on the search engine you are using. 

http://www.yahoo.com/
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2. When the search is completed, a list of sites that contain the keyword or phrase you are looking for 
is displayed.  Select a site whose description comes closest to the information you desire and click 
on its link. 

3. If there are many sites, an option that allows you to view the next 10 or so matches is displayed.  
Click on this if necessary to view the next set of links. 
If there are too many matches, you may want to use an additional keyword to narrow down the 

search.  E.g., to find the sites that contain information about the economy in Kenya, in the Search 

box, type phrase “Kenya AND Economy”. 

4. Click the Search button. 
5. From the search results, select the links that may help you get the information you require.   
 

Locate information within a Website. 

Once you access a Website, you can search for specific text or information on that site or page.   

Unlike search engines like Yahoo, Infoseek, Lycos, Web Crawler, and Excite that present you with the 

URLs or links of sites that hold information you are looking for, search engines within a Web page locate 

information within that Web page. 

1. Load the Web page to browse.  E.g., let’s use a Website: http://www.carleton.ca.  
2. Click in the Search box, and type a keyword(s), e.g., International AND Student. 

Note. When typing in a keyword, you can use logical words or operators like AND (when you want 

to display results that meet both criteria) and OR (when you want to display results that meet one of 

the two criteria). 

3. Click the Search button, to begin the search. 
4. From the Search Results screen, click on a link that is closest to your requirements. 

 
To open a favorite Web site from the Start menu. 

1. Click the Start button, point to Favorites, and then click the Web page you want.  
 

To search the Web from the Start menu. 
 

1. Click the Start button, point to Find, then click On the Internet.  
 

To use the Run command to open a Web page. 
 

1. Click Start, click Run, and then type the Internet address you want.  

If the page you are opening is one you've viewed before, the AutoComplete feature can 

complete the address for you. 

 

To find pages you've recently visited. 

To find Web sites and pages you've viewed in the last few days, hours, or minutes. 

1. On the toolbar, click the History button.  

The History bar appears, containing links for Web sites and pages visited in previous days and weeks. 

http://www.carleton.ca/
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2. In the History bar, click a week or day, click a Web site folder to display individual pages, and then 

click the page icon to display the Web page.  

Notes. 

 To return to the last page you viewed, click the Back button on the toolbar.  

 To view one of the last nine pages you visited in this session, click the arrow to the side of the Back 
or Forward button, and then click the page you want from the list.  
 

To enter Web information more easily. 

The AutoComplete feature saves previous entries you have made for Web addresses, forms, and 

passwords.  

When you type information in one of these fields, AutoComplete suggests possible matches.  

3. When typing an information in the Address bar, and the AutoComplete feature suggests what you 

want to enter in that field, click the suggestion.  If not, continue typing.  

Setting or changing a Home Page. 

Home page is the page that is displayed every time you start Internet Explorer.  

Note.  Make sure it is a page that you want to view frequently, or make it one that you can customize to 

get quick access to all the information you want, such as the Msn.com home page.  

√ To enable the user to choose or specify a page that will provide a good starting point for exploring 
the Web. 
The Home page will appear each time the user accesses the Web. 

1. Go to the page you want set as your Home page. 
2. On the Tools menu, click Internet Options.... 

The Internet Options dialog box appears. 

3. Click the General tab. 
4. Under the Home Page section, type the address of the new home page in the Address box.  

Alternatively, click Use Current to make the current Website the home page. 
5. Click the OK button. 

 
Tips.  

 To restore your original home page, click Use Default.  

 You can return to your home page anytime by clicking the Home button. 
 

Downloading Web pages and programs from the Internet 
√ To enable the user to view Web pages without being connected to the Internet. 

√ To be able to browse a site in a location that does not provide any network access. 

√ In order to free your telephone lines. 
 

http://www.microsoft.com/isapi/Redir.dll?prd=ie&clcid=&ar=home
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Downloading a Web page 

1. Load the Web page you want to download, e.g., http://www.nationaudio.com.  
2. Access all the links that you would like to read offline.  Make sure that the whole Web page is fully 

loaded before moving to the next one. 
3. On the Favorites menu, click Add to Favorites. 
4. Select the option Yes, notify me of updates and download the page for offline viewing. 
5. Click OK, and then Logoff. 

 

Downloading a program 

√ Programmers and software houses like Microsoft usually develop programs and may decide to send 
a test copy to their existing clients or to publish it on the Internet for interested users to test it for a 
specified period of time. 
 

To test such software, a user will have to download the program onto the hard disk.  A user can also 

download a movie clip or games, etc, and view it offline to save on costs. 

1. Locate a site from which you wish to download a program, e.g., http://softwarenow.iboost.com.  
2. Select the category of programs you want to download, e.g., Games. 
3. Select a game category, e.g., Racing Games. 
4. Select a game you want to download. 

Note. The window lists the properties of the program, e.g., version, file size.  Ensure that you 

understand the licence agreement, i.e., whether the program is freeware or shareware. 

Freeware is a program that is absolutely free, while Shareware program is available for a limited 

period of time. 

5. To download the program, click on the download link, e.g., Download Cars & Brix. 
6. From the File Download dialog box, select Save this program to disk option, then click OK. 
7. In the Save As dialog box, select the folder in which you wish to store the downloaded program, 

then click Save. 
Once the program is loaded, you can access the folder it was saved in and load it without being 

connected to the Internet. 

Saving pictures or text from a Web page. 

√ You can save information for future reference or in order to share with other people.  You can save 
the entire Web page or any part of it: text, graphics, or links.  

 

√ You can print Web pages for people who don’t have access to the Web or a computer.  
 

To copy information from a Web page into a document,  

1. Select the information you want to copy, on the Edit menu, click Copy. 
 

 

http://www.nationaudio.com/
http://www.nationaudio.com/
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To use a Web page image as desktop wallpaper. 

1. Right-click the image on the Web page, then click Set as Wallpaper. 
 

Saving information (a Web page) from the Internet to the Hard disk. 

√ When you come across a Web page you would want to read, but it is too long, you can save the Web 
page onto your hard disk so as to read it later on when you are off-line.  This helps in reducing the 
costs of browsing while online.   

1. Load the Web page you want to download.  
 Make sure the Web page you want to save is completely transferred to the screen of your Web 

browser. 

2. On the File menu, select Save As. 
3. In the Save HTML Document dialog box that appears, select the drive & folder where you want to 

save the page in. 
4. In the File name box, type a name for the page. 
5. In the Save as type box, select a file type. 

 To save all of the files needed to display this page, including graphics, frames, and style sheets, 

click Web Page, complete. This saves each file in its original format. 

 To save just the current HTML page, click Web Page, HTML only. This will save the information 

on the Web page, but it does not save the graphics, sounds, or other files. 

 To save just the text from the current Web page, click Text Only. This saves the information on 

the Web page in straight text format. 

6. Click Save.   
The Explorer program automatically assigns the extension .htm to the file name. 

To open a saved file. 

√ After saving a Web page, you may want to read and analyze the information at a later time.   
 

√ You may also want to send the saved file to another person via e-mail as an attachment. 
1. On the File menu, select Open.  This displays the Open dialog box. 
2. Click on the Browse button in order to locate the folder where the file is stored. 
3. Click the file, then choose Open. 

 

Note.  When you save a file in a local disk, only the text on the page is shown.  The graphics in a site are 

displayed in graphics placeholders (which appear as small rectangles). 

Graphics and Download time. 

When designing Web pages, graphics have to be incorporated sensibly into the Web page.   

Although they are appealing to the eye, the more graphics you use on a Web page, the longer the Web 

browser will take to download the page. 
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File Formats. 

The most common file formats found on the Internet are: 

- Graphic Interchange Format (GIF), and 
- Joint Photographic Experts Group (Jpeg). 
 

Generally, GIFs are used for simple page design elements like lines, buttons and dividers, while JPEGs are 

mostly used for complex photographs and images. 

Movie (video) files usually have the extension .avi, .mpg, or .mov, while Sound (audio) files have the 

extension .au, or .ra, or .ram, or .wav. 

Printing Web pages. 
√ To obtain a hard copy of the information that you have researched on and collected, for the 

purposes of reviewing later or filing. 
 

Change how a page looks when it prints. 

Before printing a Web page, it is advisable to check the settings in the Page Setup dialog box.   

This will ensure that the right Paper size, Margins and Orientation of the page are set correctly.  You can 

also add headers and footers to a Web page. 

On the File menu, click Page Setup.  

1. In the Margins boxes, type the margin measurements (in inches).  

2. In the Orientation area, click either Portrait or Landscape to specify whether you want the page 

printed vertically or horizontally.  

3. In the Header and Footer boxes, specify the information to be printed, then click OK.  

Printing the Web page 

1. On the File menu, click Print to display the Print dialog box. 

2. Set the printing options you want, then click OK.  

Creating a Bookmark 
√ When you browse the Web, you may come across sites that you want to visit regularly.   

Examples of such sites include; news sites like CNN or BBC.  You can decide to ‗bookmark‘ 

the Web page. 
 

The Bookmark feature (also known as a Hotlist or Favorites feature) allows you to store the 

addresses of Web pages that you frequently visit.  Hence, you do not have to constantly 

retype your favourite Web page addresses.  When you want to visit the site, simply select the 

bookmark from a list. 
 

1. Open the Website that you want to create a shortcut to.  E.g., http://www.cnn.com.  

2. On the Favorites menu, choose Add to Favorites. 

http://www.cnn.com/
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3. The Add to Favorites dialog box appears.  The name of the site you are in appears on 

the Name box. 

4. Under Create in: click the folder you want to add the site to, e.g., Links, then click OK. 

5. This will add the title of the Web page in the Favorites list. 

 

To go to a site using a Bookmark 
 

1. On the menu bar, select Favorites. 

2. Select the folder that holds the favorites item, e.g., Links.   

3. From the drop-down list, click CNN.com. 

 

To delete a Bookmark 
 

1. On the menu bar, select Favorites. 

2. Point to the item from the Favorites list, e.g., CNN.com. 

3. Right-click the item, and then click Delete. 

4. The Confirm File Delete dialog box appears. 

5. Click Yes, to remove the item from the list. 

Working Offline 
Connection to the Internet usually means that you are using telephone lines, and therefore incurring 

telephone charges and usage on your ISP account. 

Offline - Not connected to a network or the Internet. 

BROWSING THE WEB (INTERNET) OFFLINE. 

√ To enable the user to save on the time spent connected to the Internet, and hence reduce the general 
costs of being online. 

1. Access the Web site that you want to browse offline. 

2. Access all the links to download all the information you require. 

3. Ensure that each Web page is downloaded completely before going to the next one. 

4. On the Taskbar, right-click the Connection Indicator button, then choose Disconnect. 

 

The Connection Indicator disappears from the Taskbar showing that you are now working offline. 

After disconnecting the user can go ahead and read all the downloaded information.  The user can 

also “browse” through the site while offline provided all the pages and links are downloaded. 

Note. Some services like Internet, Usenet, Newsroom, or Shopping will not be available when you are 

offline.  To use these services, you need to re-establish the connection. 
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Making Web pages available for offline viewing. 
Offline Reading -To view a Web page without being connected to the Internet. 

You can download the page to your hard disk, disconnect from a network or the Internet, and read the 

material later. 

When you make a Web page available offline, you can read its content when your computer is not 

connected to the Internet.  

E.g., you can view Web pages on your Laptop computer when you don't have a network or Internet 

connection.  

1. On the Favorites menu, click Add to Favorites.  

2. Select the Make available offline checkbox.  

3. To specify a schedule for updating that page, and how much content to download, click 

Customize.  

4. Follow the instructions on your screen.  

Note. Before you go offline, make sure you update your pages.  To do this, click the Tools 

menu, then click Synchronize.  

To make an existing favorite item available offline. 

1. On the Favorites menu, click Organize Favorites.  

2. Click the page you want to make available offline.  

3. Select the Make available offline checkbox.  

4. To specify a schedule for updating that page, and how much content to download, click 

Properties.  

Get Help with Internet Explorer. 
 

Purpose. 
 

√ While working with Internet Explorer, you may sometimes need help on how to perform 

certain tasks or help on a particular topic of interest. 

1. On the Help menu, select Contents and Index (or press F1). 

2. The Internet Explorer Help window is displayed. 

3. Click the Contents tab. 

4. Click a book in the list, and then click a Help topic you want to look at. 

5. The Help topic contents are displayed on the right-hand side of the Help window. 

6. Read the help and click the hyperlinks (blue, underlined text) if you want to see help on 

related topics. 

7. When you have finished, click the Close button to exit help. 
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Using the Index to get Help. 

1. On the Help window, click the Index tab. 

2. Type in the first few letters of the word or topic that you are looking for. 

3. In the Index box, all the help topics are listed in alphabetical order. 

4. Click the Display button to view the information about the topic selected. 

 

Advantages of the Internet. 

i. One can download (copy) information from a Website. 

ii. The Internet has enabled the interlinking of people worldwide / globally. 

iii. It is convenient in the sense that you can access data 24 Hrs. 

iv. It is cheap, i.e., the operational cost that one may incur is low. 

v. It has brought in the technology of doing the following; E-learning, E-Agriculture, E-

commerce, E-governance, etc. 

vi. Provides up-to-date information. 

vii. It doesn’t require a lot of training to browse. 

viii. It provides entertainment facilities. 

ix. Can be used for research. 

x. Brings harmony in the world, because people can communicate and exchange ideas. 

xi. The Internet can be accessed at any part of the world. 

xii. There is always a full backup provided by the Servers, hence no data loss. 

xiii. It’s a fast way of communicating.  

xiv. It provides an easy way to use offers in Information and products.   

Internet provides information from almost all parts of the world that you need in order to make 

accurate and informed decisions. 

You will get information you need from business to education, from sports to politics, from arts to 

eating out.   

Disadvantages of Internet. 

i. It’s a technology, which is fetched for (imposed/forced on) the Third world countries. 

ii. The cost of the Internet Service Provider is high. 

iii. It is leading to exposure of morally harmful shows such as Pornography. 

iv. It leads to spread of viruses. 

v. Has proved to be unreliable especially accessing information. 

vi. No copyright rules meant to protect the property of an organization. 
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Electronic Mail (E-Mail). 
 

About e-mail. 
 

Electronic mail (also known as e-mail) is one of the common services provided by the Internet. 

 E-Mail is a worldwide system for sending & receiving electronic messages from one computer to 
another. 

 E-Mail (Electronic mail) refers to electronic messages sent over the Internet or a network.  E-

mail can contain both text & files. 
With e-mail, users can create and send messages to one user, several users, or all the users on a 

distribution list. 

Most e-mail software enable users to send text messages. In addition, users can attach files from Word 

processors, Spreadsheets, Reports, production data, etc, and then send them by e-mail.  

Most E-mail packages allow you to do the same things you do with regular paper mail.  You can file 

messages in electronic file cabinets, forward copies of messages to other users, send “carbon copies” of 

messages, and so on.  The E-mail packages also allow you to filter or organize messages by priority.  E.g., 

all messages from a particular user (e.g., your boss) could be given top priority, so that they always 

appear at the top of your list of messages. 

However, E-mail is a much faster, economical & convenient way of sending messages to family, friends 

and colleagues than the paper mail (usually called “Snail mail”).  Messages can be sent or received 24-

hrs a day.  With “Snail mail” a message or a letter is sent to the recipient through the Post office and 

takes days or weeks before reaching the destination.   

 

Components required. 
For one to be able to communicate using e-mail, the following components are needed: 

1). A Computer - where you will send or receive the e-mail messages. 

2). An E-mail program. 
Your computer must be installed with an e-mail program that lets you send, receive and manage 

your e-mail messages.   

Examples of E-mail programs;  

 Microsoft Outlook, Outlook Express, & Microsoft Exchange from Microsoft. 
 Communicator from Netscape.  
 Lotus Notes. 
 Eudora. 
 

3). E-mail address of the sender & the address of the receiver. 
 

4). An Internet Service Provider (ISP) - company who will deliver your message to the receiver. 


